9 Draw
(Figures/Text)

This chapter provides an overview of the draw/edit tools and how to draw figures and text in
GP-Pro EX.
Read “9.1 Settings Menu” (page 9-2) first, then skip to the explanations as required.
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Settings Menu

9.1 Settings Menu

Drawing Pictures

O A

Draws aline, rectangle, and other pictures.

& 921 Drawing Picture Lists”
(page 9-6)

Writing Text

Production Inventory

Places text on the screen.

& Setting Procedure (page 9-23)
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Editing Objects

) ) &7 941 Introducing Edit Tools”
Enlarging/Reducing Handle (page 9-26)
/

Drag it to a desired size.

Moving an Object Handle

................

Drag it to a desired position.

Runs screen edit operations such as enlarging, reducing
or moving.

Changing Colors, Line Types and Patterns

& w95 Changing Colors, Line
Types and Patterns” (page 9-34)

Changes a picture's color, line type, and pattern.

Editing a Part

&~ «96.1 Editing Parts” (page 9-38)
Lamp

[ E3

Edit S
- [ 4+ )

Changes the shape, color, and |abel of a part.
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Using a Screen for Various Purposes

B1

Setting Input
Screen

B100

Create a screen for various
purposes.

(Call Screen )

B2

Active Operations
Screen

B3

Active Monitoring
Screen

You can call and display
various screens.

& Setting Procedure (page 9-50)

Editing a Picture on Another Screen

Drag and Drop

Package

A0S

Objects registered in
a package

Place it on the screen and edit it.

& «98.1 Placing Pictures
Registered in the Package”
(page 9-53)

& «98.2 Registering Pictures in the
Package” (page 9-55)

Setting up Grids

AMaimis QAo
Ivielnu ocreell
= Setting Input = =Acztive Opera‘\:ic“.s=
[ Screen 1 | Screen i
.A(‘ti\re Monitoring | . | a n
B oen M M Alarm Screen Bl
. oClIee . . .

Displays an equally spaced grid on the editing screen
and places parts with reference to an intersecting point.

& Setting Procedure (page 9-57)
&~ Detail (page 9-57)
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Selecting a Screen from Template

Select a template.

7N

Template List
Screen Screen Screen
Image 1 Image 2 Image 3 Screen |mage 3
Screen Screen Screen
Image 4 Image 5 Image 6

Edits screens from atemplate screen.

&~ «99.2 Selecting a Screen from
Template” (page 9-60)

Pasting an Image

Proface Pro-face

BMP, JPEG, etc.

Converts image data and
places it on the screen.

& Setting Procedure (page 9-64)
@:Target Image (page 9-63)

Drawing a Detailed Picture

Draws a picture pixel by dot.

& Setup Procedure (page 9-66)
&~ Introduction (page 9-66)
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9.2 Drawing Pictures

9.2.1 Drawing Picture Lists

Picture Description
Dot Draws adot.
u & w922 Drawing by Pixels” (page 9-6)
Line/ Draws aline/polyline.
Polyline f &~ 9 2.3 Drawing Line/Polyline” (page 9-7)
Rectangle Draws arectangle.
|:| & «924 Drawing Rectangles” (page 9-8)
Polygon Draws a polygon.
'-f:}' “9.2.7 Drawing Polygons” (page 9-16)
Circle/Oval Drawsacircle/oval.
@l & w925 Drawing Circles/Ovals” (page 9-11)
Arc/Pie Draws an arc/pie.
& 926 Drawing Arcs/Pies” (page 9-14)
Scale Draws the graph scales.
E &~ 928 Drawing Scales” (page 9-18)
Table Draws atable.
E & «929 Drawing Tables” (page 9-20)

9.2.2 Drawing by Pixels

The Dot feature can draw one to five dots at atime.
From the [Draw (D)] menu, select [Dot (D)] command or click = to place adot on the
screen. If you click | and double-click the placed [Dot], the following dialog box appears.

#* Dot

Size F E g

Color =7 | EBlik [Mane |

oK@ | Gancel |

&~ For display colors, refer to “9.5.1 Setting Colors” (page 9-34)
¥~ For blinking, refer to “9.5.2 Setting Blinks” (page 9-37)
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9.2.3 Drawing Line/Polyline

Drag the mouse to draw aline from the start to the end. For the polyline, click to designate
the start, the mountain fold and the end, and right-click to set.

From the [Draw (D)] menu, select [Line (L)] or [Polyline (U)], or click ' .* or ~* toplacea
line/polyline on the screen. If you click | and double-click the placed [Line] or [Polyline],
the following dialog box appears.

* If you press and hold the [Shift] key while placing aline, you can draw aline

at an angle of 0 degrees and 90 degrees.

* If you place aline while pressing the [Ctrl] key, you can draw aline
extending from the center. If you place aline while pressing the [Ctrl] and
[Shift] keys at the same time, you can draw aline of O degrees or 90 degrees
extending from the center.

 To edit after placing the line and polyline, click on the selected line to change
to ayellow handle. You can drag the line to change the shape.

 For apolyline, you can left click and drag to draw, similar to handwriting.

,_—E_‘: Line/Polyline

Line Tvpe [— Solid Line ]

Line Thickness lﬁﬂ

frrow Shape |_ MHone ﬂ

Frrow Direction | =

Display Color [C17 x| Blick  [None =]
Pattern Calar |- j Elifk ’—_|

Cancel |

Setting Description

Line Type Select the line type from [Solid Line], [Dotted Line], [Dash Line], [Chain
Line], or [Two-Dot Chain Line].
& «95.3 Setting Line Types” (page 9-37)

Line Thickness Set the line thickness within the range of one to nine dots.

* When line types other than [Solid Line] are selected in [Line Type], the
Setting range is one to two dots.

Arrow Shape Select the arrow shape from |—.4- Jl= Or |l

Arrow Direction Select the arrow direction from [Start], [End], or [Both Ends].
Display Color Set the line color.
& w951 Setting Colors” (page 9-34)
Pattern Color Select the pattern color. This function can be used only when line types

other than [Solid Line] are selected in [Line Type].

Continued
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Setting Description

Blink Select whether or not the Part will blink, and the blink speed. You can
choose different blink settings for [Display Color] and [Pattern Color] of
the part.

» There are cases where you can and cannot set Blink depending on the
Display and System Settings [Color Settings].
&~ 951 Setting Colors” (page 9-34)

9.24 Drawing Rectangles

Draw arectangle by dragging the mouse to specify two opposite corners.
In the [Draw (D)] menu, select [Rectangle (R)] or click [ to place arectangle on the
screen.

.| Double-click the placed [Rectangl€] to display the following dialog box.

* If you press and hold the [Shift] key while drawing arectangle, the object is
forced into a square.

« If you place arectangle while pressing the [Ctrl] key, you can draw a
rectangle spreading out from the center. If you place arectangle while
pressing the [Ctrl] and [Shift] keys at the same time, you can draw a square
spreading out from the center.
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,;_}"_': Rectangle [ %]
—I¥ Border
Line Type |— 5olid Line =]
Line Thickness ﬁg
Display Color |7 ~| Blink Mone hd
Pattern Color | 0 ~| Blink Mone =
Chamfer — T Fill
[Fone | Pattern | Mene |
Mumber of Pixels Digplay Golor |17 | Blink |None j
m_‘g Pattern Color [MEED = Blink  [Mone =
| St
Direction IBottom Right j
Cilaor Iﬁ
Shadow Distance lﬁ_}g

Cancel

Setting

Description

Border

Line Type

Select the line type from [Solid Line], [Dotted Line], [Dash Lin€],
[Chain Line], or [Two-Dot Chain Lin€].
&~ «953 Setting Line Types” (page 9-37)

Line
Thickness

Set the line thickness within the range of one to nine dots.

* When other line types than [Solid Line] are selected in [Line Type],
the line thickness is fixed at one dot.

Display Color

Set the border color.
w951 Setting Colors” (page 9-34)

Pattern Color

Select the pattern color. This function can be used only when line
types other than [Solid Line] are selected in [Line Type].
F~ w954 Setting Patterns” (page 9-37)

Blink

Select whether or not the Part will blink, and the blink speed. You can
choose different blink settings for the [Display Color] and [Pattern
Color] of the part.

» There are cases where you can and cannot set Blink depending on
the Display and System Settings [Color Settings].
& 951 Setting Colors” (page 9-34)

Continued
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Setting

Description

Fill

Pattern

Set a background pattern for the rectangle.
& «95.4 Setting Patterns” (page 9-37)

Display Color

Set acolor for the rectangle.
& «95.1 Setting Colors” (page 9-34)

Pattern Color

Set the background pattern color for the rectangle.
&~ «95.4 Setting Patterns” (page 9-37)

Blink

Select whether or not the Part will blink, and the blink speed. You can
choose different blink settings for the [Display Color] and [Pattern
Color] of the part.

* There are cases where you can and cannot set Blink depending on
the Display and System Settings [Color Settings].
& «95.1 Setting Colors” (page 9-34)

Shadow

Direction

Select the shadow direction from [Top Left], [Bottom Left], [Top
Right], or [Bottom Right].

Color

Set the shadow color.
&~ w951 Setting Colors” (page 9-34)

Shadow
Distance

Set the width of the picture and the shadow within the range of 1 to
16.

Chamfer

Select the chamfer shape from [None], [Ling], or [Circle].

Number of Dots

Designate the number of dots for chamfer from 1 to 999.

|

Set the number of dots in this space.

¥
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9.25 Drawing Circles/Ovals

Draw acircle or oval by dragging the mouse to specify the center point and one point on the

circle.
From the [Draw (D)] menu, select [Circle/Oval (C)] or click & to place acircle/oval on the

screen. If you -,| double-click the placed [Circle/Oval], the following dialog box appears.

« If you press and hold the [Shift] key while placing an object, you can draw a
circle.

* If you place acircle/oval while pressing the [Ctrl] key, you can draw acircle/
oval spreading out from the center. If you place a circle/oval while pressing
the [Ctrl] and [Shift] keys at the same time, you can draw acircle spreading
out from the center.
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#* Circle/Dval

— v Border
Line Tvpe

— Solid Line |
-

Display Golor [C17 | Blink MNone
Pattern Colar Iiﬂ = Blink Mone

Line Thickness

Ll

— Fill
Fattern | Mane ;I

Display Calar [ 7 _=| Blink Maone
Fattern Colar I-D | Blink Maone

— 1 Shadow
Direction Eottom Right LI

Calar - vl

Shadow Distance

Ll

Cancel

Setting

Description

Border

Line Type

Select the line type from [Solid Line], [Dotted Ling], [Dash Ling],
[Chain Ling], or [Two-Dot Chain Ling].
& 953 Setting Line Types” (page 9-37)

Line
Thickness

Set the line thickness within the range of one to nine dots.

* When other line types than [Solid Line] are selected in [Line Type],
the line thickness is fixed at one dot.

Display Color

Set the border color.
& «95.1 Setting Colors” (page 9-34)

Pattern Color

Select the pattern color. This function can be used only when line
types other than [Solid Line] are selected in [Line Type].
& «95.4 Setting Patterns” (page 9-37)

Blink

Select whether or not the Part will blink, and the blink speed. You can
choose different blink settings for the [Display Color] and [Pattern
Color] of the part.

 There are cases where you can and cannot set Blink depending on
the Display and System Settings [Color Settings].
w951 Setting Colors” (page 9-34)

Continued
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Setting Description

Fill Pattern Set the background pattern for the circle/oval.
& «95.4 Setting Patterns” (page 9-37)

Display Color | Set acolor for the circle/oval.
& «95.1 Setting Colors” (page 9-34)

Pattern Color | Set the background pattern color for the circle/oval.
&~ «95.4 Setting Patterns” (page 9-37)

Blink Select whether or not the Part will blink, and the blink speed. You can
choose different blink settings for the [Display Color] and [Pattern
Color] of the part.

* There are cases where you can and cannot set Blink depending on
the Display and System Settings [Color Settings].
& «95.1 Setting Colors” (page 9-34)

Shadow | Direction Select the shadow direction from [Top Left], [Bottom Left], [Top
Right], or [Bottom Right].
Color Set the shadow color.
&~ w951 Setting Colors” (page 9-34)
Shadow Set the width of the circle/oval and the shadow within the range of 1
Distance to 16.

* You can set the width and height of acircle/oval in the [Properties (P)].
However, if you set the width or height to an even number, it will be drawn
with one less dot on the GP.

In GP-Pro EX On the GP

Height, width 100 dots Height, width 99 dots
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9.2.6 Drawing Arcs/Pies

Draw an arc or pie by dragging the mouse to specify the center point and one point on the
circle, and specify the start angle and end angle in the dialog box. You can select an arc or
pie.

From the [Draw (D)] menu, select [Arc/Pie (A)] or click ¢ to place an arc/pie on the
screen. If you click -| and double-click the placed [Arc/Pie], the following dialog box

appears.
* If you press and hold the [Shift] key while placing an object, you can draw a
circlearc.

« If you place an arc/pie while pressing the [Ctrl] key, you can draw acircle/
oval's arc spreading out from the center. If you place an arc/pie while
pressing the [Ctrl] and [Shift] keys at the same time, you can draw acircle's
arc spreading out from the center.

« |f you edit an arc/pie after placing it, you can change the arc/pi€'s start angle
and end angle by operating the yellow handlein the selected state.

* You can set the width and height of an arc/pie in the [Properties (P)].
However, if you set the width or height to an even number, it will be drawn
with one less dot on the GP.

-
Line Type | — 5olid Line |
__Line Thickness ﬁ —] g
Digplay Golor =7 | Blink |N0ne j
Fattern Colaor |- ﬂ Elink | J
............. r
P.rc: Pattern | =l
il Display Golor | =l EBlink |
Start Anele Pattern Golor [ | Blink =l
p =) |
=) -
End Anel
e e Direction
Fo =1 |
Color | -
Shadow Distance EJ
(o] giw)] | Cancel
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Setting

Description

Border

Line Type

Select the line type from [Solid Lin€], [Dotted Line], [Dash Ling],
[Chain Line], or [Two-Dot Chain Lin€].

Line
Thickness

Set the line thickness within the range of one to nine dots.

* When other line types than [Solid Line] are selected in [Line Type],
the line thickness is fixed at one dot.

Display Color

Set the arc/pie border color.

Pattern Color

Select the pattern color. This function can be used only when line
types other than [Solid Lineg] are selected in [Line Type].

Blink

Select whether or not the Part will blink, and the blink speed. You can
choose different blink settings for the [Display Color] and [Pattern
Color] of the part.

» There are cases where you can and cannot set Blink depending on
the Display and System Settings [Color Settings].
& w951 Setting Colors” (page 9-34)

Fill

Pattern

Select a background pattern for the pie.

Display Color

Set the pie's color.

Pattern Color

Set the background pattern color for the pie.

Blink

Select whether or not the Part will blink, and the blink speed. You can
choose different blink settings for the [Display Color] and [Pattern
Color] of the part.

» There are cases where you can and cannot set Blink depending on
the Display and System Settings [Color Settings)].
& «95.1 Setting Colors” (page 9-34)

Shadow

Direction

Select the shadow direction from [Top Left], [Bottom Left], [Top
Right], or [Bottom Right].

Color

Set the shadow color.

Shadow
Distance

Set the width of the arc/pie and its shadow within the range of 1 to 16.

Arc/Pie

Select from [Arc] or [Pi€].

Start Angle/End Angle

Set the [Start Angle] or [End Angle].

GP-Pro EX Reference Manual
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9.2.7

Drawing Polygons

To draw a polygon, click each apex and right-click to define a polygon.
From the [Draw (D)] menu, select [Polygon (P)] or click < to place a polygon on the
screen. If youclick .| and double-click the placed [Polygon], the following dialog box

appears.

» Toedit apolygon, click on alineinthe polygon to changeto ayellow handle.
You can drag aline on the polygon to change the shape.

#* Polygon
Line Type . | — 5olid Line |
Line Thickness = ﬂ
Dizplay Calar |7 +| Blink |Mone v
Fattern Gaolor | N ~| Blink
[~ Fill
Fattern | ﬂ
Dizplay Calar [ =] Blink. | J
Pattern Color [ =] Blink. | J
I
Direction ’—_|
Golar e o
Shadow Distance EJ
(o] giw)] | Cancel
Setting Description
Border | Line Type Select the line type from [Solid Line], [Dotted Line], [Dash Lin€],
[Chain Line], or [Two-Dot Chain Lin€].
w953 Setting Line Types” (page 9-37)
Line Set the line thickness within the range of one to nine dots.
Thickness
» When other line types than [Solid Line] are selected in [Line Type],
the line thickness is fixed at one dot.
Display Color | Set the border color.

& «95.1 Setting Colors” (page 9-34)

Pattern Color

Select the pattern color. This function can be used only when line
types other than [Solid Line] are selected in [Line Type].
& «95.4 Setting Patterns” (page 9-37)

Blink

Select whether or not the Part will blink, and the blink speed. You can
choose different blink settings for the [Display Color] and [Pattern
Color] of the part.

» There are cases where you can and cannot set Blink depending on
the Display and System Settings [Color Settings].
& «95.1 Setting Colors” (page 9-34)
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| Setting

Description

Continued

Fill Pattern

Set a background pattern for the polygon.
&~ «95.4 Setting Patterns” (page 9-37)

Display Color

Set acolor for the polygon.
w951 Setting Colors” (page 9-34)

Pattern Color

Set a background pattern's color for the polygon.
& «95.4 Setting Patterns” (page 9-37)

Blink

Select whether or not the Part will blink, and the blink speed. You can
choose different blink settings for the [Display Color] and [Pattern
Color] of the part.

 There are cases where you can and cannot set Blink depending on
the Display and System Settings [Color Settings].
&~ 951 Setting Colors” (page 9-34)

Shadow | Direction

Select the shadow direction from [Top Left], [Bottom Left], [Top
Right], or [Bottom Right].

Color Set the shadow color.

& «95.1 Setting Colors” (page 9-34)
Shadow Set the width of the polygon and its shadow within the range of 1 to
Distance 16.
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9.2.8 Drawing Scales

Draw a scale by dragging to specify two opposite corners. Set the divisions of the scalein the
following dialog box.

From the [Draw (D)] menu, select [Scale (S)] or click E to place ascale on the screen. If
you click -,| and double-click the placed [Scal€], the following dialog box appears.

» To edit ascale after placing it, click theline in the selected state to make it a
yellow handle. You can change the scale type by operating the yellow handle

axIS.
.if: Scale
Scale
Line Type |—Salid Line =l
Line Thicknesz F 3; ﬂ
Display Galar ||:|'.-‘ j Blink. |N0ne j
Fattern Color |- j Blirk: | J
Major Scale
Divizions F E ﬂ
Leneth = =&
= Minor Scal
 Bar {Horizantal? L
~ frc Divizions Ej
Leneth 3 J
Start Angle
E J [v Draw Axis
End Anele J fixis Position Left hd
QK {0} | Cancel
Setting Description

Scale Line Type

Select the line type from [Solid Lin€], [Dotted Ling], [Dash Ling],
[Chain Line], or [Two-Dot Chain Lin€].
& «95.3 Setting Line Types” (page 9-37)

Line Set the line thickness within the range of one to nine dots.
Thickness
* When line types other than [Solid Line] are selected in [Line Type],
the setting range is one to two dots.
Display Color | Select the scale color.

& «95.1 Setting Colors” (page 9-34)

Pattern Color

Select the pattern color. This function can be used only when line
types other than [Solid Line] are selected in [Line Type].
&~ «954 Setting Patterns” (page 9-37)

Blink

Select whether or not the Part will blink, and the blink speed. You can
choose different blink settings for the [Display Color] and [Pattern
Color] of the part.

* There are cases where you can and cannot set Blink depending on
the Display and System Settings [Color Settings].
& «95.1 Setting Colors” (page 9-34)

Continued
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Setting Description
Major Divisions Select from 1 to 999 large-scale axis divisions.
Scale
( Large Scale
Length Select the large scale length from 2 to 3,072.
Minor Divisions Select from 2 to 999 minor-scale axis divisions.
Scale
Minor Scale
Length Select the minor scale length from 1 to 3,071.
Draw Axis Position | Select the scale direction from the axis from [Left] or [Right].
Axis
Type Bar (Vertical) | Displaysthe scale for avertical bar graph.

Bar
(Horizontal)

Displaysthe scale for a horizontal bar graph.

Arc

Displays the scale for acircle graph.

* You can set the width and height of ascalein [Edit (E)], [Change
Attributes (M)]. However, if you set the width or height to an even
number, it will be drawn with one less dot on the GP.

Start Angle/End Angle

Set the [Start Angle] or [End Angle].
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9.2.9 Drawing Tables

Draw atable by dragging to specify two opposite corners. Set the rungs and number of

columnsin the following dialog box.

From the [Draw (D)] menu, select [Table (T)] or click B2 and to place atable on the screen.

If you double-click the placed [Tabl€], the following dialog box appears.

» To edit the table after placing it, click aline of the table in the selected state
to make it ayellow handle. You can change the inside border spacing by

operating the yellow handle.

» BB When you click thisicon, drag to select the table frame borders and
move the pointer - to the drawing areato place the defined table.

#* Table

Pixels Between

Equal Spacing hd

Divizions
Wertical E E ﬂ
Harizontal E E ﬂ

Show Border

Line Type | — 5olid Line |

Line Thickness lﬁﬂ

Display Galor  [C17 =] Blick  [None =]
Pattern Color  [WEmCD =] EBlink ’—_|
Ihzide Border

Line Tvpe | — 5olid Line |

Line Thickness lﬁﬂ

Display Galor  [C17 =] Blick  [None =]
Pattern Colar L >| Blink

[~ Fill

Pattern | |

Display Golor [EE045 =]  Blick  [rone 7]
Fattern Colaor ’—Ll Elink ’—_|

Cancel |
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Setting

Description

Show
Border

Line Type

Select the line type from [Solid Lin€], [Dotted Line], [Dash Ling],
[Chain Line], or [Two-Dot Chain Lin€].
& «953 Setting Line Types” (page 9-37)

Line
Thickness

Set the line thickness within the range of one to nine dots.

» When other line types than [Solid Line] are selected in [Line Type],
the line thickness is fixed at one dot.

Display Color

Set the outer border color for the table.
& «95.1 Setting Colors” (page 9-34)

Pattern Color

Select the pattern color. This function can be used only when line
types other than [Solid Line] are selected in [Line Type].
& «95.4 Setting Patterns” (page 9-37)

Blink

Select whether or not the Part will blink, and the blink speed. You can
choose different blink settings for the [Display Color] and [Pattern
Color] of the part.

 There are cases where you can and cannot set Blink depending on
the Display and System Settings [Color Settings].
& «95.1 Setting Colors” (page 9-34)

Inside
Border

Line Type

Select the line type from [Solid Line], [Dotted Line], [Dash Line],
[Chain Line], or [Two-Dot Chain Lin€].
& «953 Setting Line Types” (page 9-37)

Line
Thickness

Set the line thickness within the range of one to nine dots.

* When other line types than [Solid Line] are selected in [Line Type],
the line thickness is fixed at one dot.

Display Color

Set the inside border color for the table.
&~ «95.1 Setting Colors” (page 9-34)

Pattern Color

Select the pattern color. This function can be used only when line
types other than [Solid Line] are selected in [Line Type].
& 954 Setting Patterns” (page 9-37)

Blink

Select whether or not the Part will blink, and the blink speed. You can
choose different blink settings for the [Display Color] and [Pattern
Color] of the part.

* There are cases where you can and cannot set Blink depending on
the Display and System Settings [Color Settings].
& «95.1 Setting Colors” (page 9-34)

Continued
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Setting

Description

Fill Pattern

Select a background pattern for the table.
& «95.4 Setting Patterns” (page 9-37)

Display Color

Set the table color.
& «95.1 Setting Colors” (page 9-34)

Pattern Color

Set the background pattern color for the table.
&~ «95.4 Setting Patterns” (page 9-37)

Blink

Select whether or not the Part will blink, and the blink speed. You can
choose different blink settings for the [Display Color] and [Pattern
Color] of the part.

* There are cases where you can and cannot set Blink depending on
the Display and System Settings [Color Settings].
& «95.1 Setting Colors” (page 9-34)

Pixels Between

Select from [Equal Spacing] or [Free].
» Equal Spacing
The row width and column width are made equal.
* Free
The row width and column width can be adjusted freely.

Divisions

Designate the number of rows [Vertical] and number of columns
[Horizontal] in the table from 1 to 30.
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9.3 Writing Text

Draw text on the drawing screen.

To draw text in order to switch the screen display languages or display content while
operating the GP, use atext table. For the settings, refer to “ 15.4 Changing Languages
(Multilanguage)” (page 15-16) .

9.3.1 Setup Procedure

 Pleaserefer to the settings guide for details.
& «9.12.1 Text Settings Guide” (page 9-77)

To place the text "Production Inventory” on the drawing screen.

Production Inventory

1 From the [Draw (D)] menu, select [Text (S)] or click A to place text on the screen.

| Draw (D)
Select Range (E)

A Teut(s)

Dat (D)

Line (L)
Palyling (L)
Rectangle (R)
Palygan (P
Circley/Cvval (C)
ArcPie (A)
Srale (M)
Image Placement (T)
Call Screen (D)

H SEME- > O0CO x> -

Takle (T)
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2 Inthetoolbar, click the pointer icon | and select the placed text. When the text border
appears, drag to adjust its size and position.

,f_‘: Text
" Text Table
Fant
Fant Type Standard Font | Text Size 816 Pixels «
Display Laneuage |ASCI | Text Attribute  |Mormal -
Direction Harizontal |
Caolor
Text Color ||:|'." j Elink |N0ne j
=== Backeround Color |Transparent j Elirk. | J
e spacie g Shadow Colar [ — =l Bk | =]
Text
(o] Qiw)] | Cancel
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4 Designate the font and size and input text to place in the Input Text border.

,f_‘: Text
(¢ Direct Text " Text Table

Fant
Fant Type Standard Fant | TextSize ’W
Display Language  [25C | Testatribute  [Momal x|
Direction Harizantal =
Colar
Tesxt Colar |I:I 7 j Elink |N0ne ﬂ

= =|= Background Calor | Trarsparent | ik | J

LieSpecns 7 =] 5] Shadaw Color [ — =l Bk | |

Production Inwventory

QK. () | Cancel

5 Click [OK] and the input text "Production Inventory" will be placed.
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9.4 Editing Objects

9.4.1 Introducing Edit Tools
Setting Description
Cut Cut the object (Parts, Text, Figure). You can place the cut

db

object on the screen with [Paste].

Operation Procedure
You can cut an object by selecting adesired object and click
[Cut] in the [Edit] menu.

Copy

Copies the selected object. Place it on the screen by using the
[Paste].

Operation Procedure
You can copy by selecting adesired object and click [Copy] in
the [Edit] menu.

Paste

Pastes the copied or cut object onto a screen.

Operation Procedure
You can paste the abject you copied or cut by clicking [Paste]
in the [Edit] menu.

* When pasting from one screen to another, you can paste the
object to the same position as the other screen.

Duplicate

Copies multiple pictures at atime. When duplicating parts, you
can automatically assign the next consecutive address after the
source part's address to the destination part.

& 945 Duplicate” (page 9-28)

Delete

by

Deletes an object.

Operation Procedure
You can delete by selecting the desired object and clicking
[Delete (D)] in the [Edit] menu.

Select All

Selects al the objects on the screen.
You can also specify the range to drag multiple objects.
&~ 9 4.2 Selection Method” (page 9-27)

Edit Vertex

You can edit, delete or insert each vertex coordinate of a
polyline or polygon.
&~ « m Edit Vertex” (page 9-30)

Group

You can group multiple objects together and treat them as one
unit.
&~ w947 Grouping (Ungrouping)” (page 9-31)

You can change the order of placed overlapping objects.
&~ «9.4.8 Order” (page 9-31)

Continued
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Setting Description

Place/ You can adjust the positions of multiple objects (Align Right,
Align 1= =|| [agF] | ol Align Left, Align Center, etc.).
&~ “9.4.9 Aligning” (page 9-32)

= of | 120
Rotate/ * Rotate
Flip Rotates the object by 90 degrees.
&~ %9.4.10 Rotating Right or Left” (page 9-32)
« Flip

4]
alv| |25

Flips the object horizontally or vertically.

I3
& 9.4.11 Reversing X-Axis (Vertical)/Y-Axis (Horizontal)” (page 9-33)

Others Setsagrid and guidelinesto align a part with another one.
& w99 Creating a Screen from a Template” (page 9-57)

9.4.2 Selection Method

There are two ways to select an object: click the object directly or specify the rangeto drag
multiple surrounding objects.

* To select one of the overlapping objects, click the object while pressing the
[Ctrl] key. Each object becomes in the selective state in turn, and you can
select the target object.

» Torelease a particular object from the selected objects, click the target object
while pressing the [ Shift] key.

» To add a particular object to the selected objects, click the target object while
pressing the [Shift] key.

9.4.3 Enlarging and Reducing the Size

Select the target object and hover the cursor on the handle. When the cursor turnsto «—, you
can zoom in or out and drag the object to the appropriate size.

Handle

Drag it to a desired size.

* |f you select an object and move the four-cornered handles while pressing the
[Shift] key, you can enlarge/reduce it with the same horizontal to vertical
ratio.

« If you usethe[1], [-], [«], and [{] keys with the cursor on the object
handle, you can enlarge/reduce the object by the dot.

GP-Pro EX Reference Manual 9-27



Editing Objects

9.4.4 Moving Objects

Select the target object and hover the cursor on the object. When the cursor turnsto <, you
can drag the object to the appropriate location.

Handle

Drag it to a desired position.

* |f you move while pressing the [Shift] key, you can move the object
horizontally or vertically.
« If youusethe[T], [-], [«], and [{] keys with the object selected, you can
move the object adot at atime.

9.45 Duplicate

Copies multiple pictures at atime.
Right-click while selecting the object and click [Duplicate (W)].

» When duplicating parts, you can automatically assign the next consecutive
address after the source part's address to the destination part.
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Duplicate Description
* In X Direction
Set the number of display positionsin the X direction from 1
to 99.
* Pixels Between

B Mumber of Resulting
= In ¥ Direction 5
Pixelz Between 0O
= In Y Direction 3

Pixelz Between 0O

Direction of Copies =
Duplicate Comment Yes
Mouze defines the Enable
[l Azzien Addresses Add
Ihcrement Each Adi1
=l Azzien Individual &
[PLC1T400000  Add

oK@ | ocancel |

4

Set the number of dots between objects from 1 to 99 dots.

* In Y Direction
Set the number of display positionsintheY direction from 1
to 99.

* Pixels Between
Set the number of dots between aobjects from 1 to 99 dots.

« Direction of Copies

Select the disﬂar direction from @ , , , \ﬂ

,Eor M

» When you add addresses, sequential addresses are assigned
in the specified direction according to the address addition
width.

* Duplicate Comment
The copy source comment is reflected in the copy
destination.

* Mouse defines the range
Using the defined interval, makes copies that fit into the
range.

» The minimum settings range depends on the size of the parts
of the copy source and the number of copies. You cannot
move the cursor to this range.

» Assign Addresses
You can assign sequential addresses from the copy-from
addresses according to the [Increment Each Address by].

* Increment Each Address by
Designates an address interval. When the copy-from
addresses are Bit addresses, addresses are added by the Bit.
When the copy-from addresses are Word addresses,
addresses are added by the Word.

« Assign Individual Addresses
When multiple addresses are set to one object, you can
designate whether or not to add each address.
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9.4.6 Changing Attributes

You can change object attributes such as color or address.
To change attributes, double-click the object while selecting it or select [Change Attributes
(M)] from the [Edit] menu.

» When multiple objects are selected, you cannot change attributes.

Line Type [—soidine o B
Line Thickness Elg
Arrow Shape — More hd

Arrow Direction

Display Color “:I? ﬂ Elink, ‘Nnne
Fattern Golor ‘- j Elirk. ‘

QK 0 Cancel

B Edit Vertex

You can edit, delete, or insert each vertex coordinate of a polyline or polygon.

To edit the object's vertex, click aline in the selected state to change it to ayellow handle.
Change the shape of the object by clicking an arbitrary line. To delete the vertex, right-click
on the vertex and select [ Del ete Vertex].

GP-Pro EX Reference Manual 9-30



Editing Objects

9.4.7 Grouping (Ungrouping)

You can group multiple objects and handle them as one object. To do so, select multiple
objects, right-click, and click [Group (E)]. To ungroup, click [Ungroup (G)].

Cut (T}
Copy )

Duplicate (i)
Delete (D)
Select All (L)

Order (O}
Place/flien (4

Rotate/Flip (B
Grid Settings
Guideline Settings
Open Screen Option

9.4.8 Order

When the placed objects are overlapping, you can change the placement order. Select and
right-click the object whose order you want to change, click [Order (O)], and select the object
order from [Bring to Front], [Send to Back], [Move Forward], or [Move Backward]. In the

following example, the oval is moved backward.

o

cut (T) Ctrhx
Copy (C) Ctr+C

Duplicate (W)
Delete (D) Del
Select Al (L) Ctrie

Change Attributes (M)

[}  Bring to Front (T)
Send to Back (K)

RotatefFip R)

Grid Settings
GLickling Settings
Open Screen Option

Cirl+3
Crl+C

Cel
Ctrl+&
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9.4.9 Aligning

You can align the position of multiple objects. Select the objects that you want to aign, right-
click, and then select [Align Left (L)], [Right (R)], [Top (T)], [Bottom (B)], [Align Center
(Horizonta) (C)], [Align Center (Vertical) (M)], or [Others (E)] from [Place/Align (A)]. In
the following example, the rectangle, polygon, and circle are all aligned to the top.

Cut T} G
Copy () Crl

Duplicate ()
Delete (O Del
Select All U Cirleh

9.4.10 Rotating Right or Left

You can rotate the object to the right and left 90 degrees at atime. Right click to select the
object you want to rotate, select the [Rotate Right (E)], [Rotate Left ()] in [Rotate/Flip (R)].
The following example describes placement of aright-rotated polygon.

Qut (1)
Copy (C)

Duplicate (W)
Delete (D)
select Al (L)

Change Attributes (1)
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9.4.11 Reversing X-Axis (Vertical)/Y-Axis (Horizontal)

You can flip the object on the X-Axis (vertical) or the Y-Axis (horizontal) of the center line
of the object. Right-click to select the desired object and select [Flip Horizontal (H)] or [Flip
Vertical (V)] from the [Rotate/Flip (R)]. The following example shows the position of a
polygon flipped horizontally. Please note that only the display position of the screen, marks,
parts, and text are reflected.

cut ()
Copy (©)

Duplicate (W)
Delete (D)
Select Al (L)

Change Attributes (1)

Edit Vertex

Order (Q)

9.4.12 Changing Coordinates

You can change the position and size of an object by designating a coordinate in the
[Properties (P)]. The reference of the coordinate is the top left of an object.

Filled Polygon

L =

Altribute Mame W alue

Top Left ¥-Coordinat 140
Top Left ¥-Coordinat 140

‘width 140
Height 1000 S
¥ Paolygon
Border On
¥ Border
Line Type = Solid Line

Line Thickness 1
Dizplay Color /7
Blink. Mone
Fill off
Decoration

« |f the [Propertieg] tab is not displayed in either the work space or the screen
drawing area, from the [View (V)] menu, point to [Work Space (W)] and
select [Properties (P)].
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9.5

9.5.1

Setting Colors

B List of Available Colors

Changing Colors, Line Types and Patterns

Model Display Device Display Color Designated Number of
Colors in Drawing
AGP-3200T TFT Color LCD 256 Colors, None Blink 256 Colors
64 Colors, 3-Speed Blink 64 Colors
AGP-3200A Monochrome LCD 8 Levels, 1-Speed Blink Monochrome 8 Levels
AGP-3302B | Blue-mode 16 Levels, 3-Speed Blink 16 Levels
Monochrome LCD
AGP-3301L Monochrome LCD Monochrome, 16 Levels, 3- Monochrome 16 Levels
Speed Blink
AGP-3301S | STN Color LCD 4096 Colors, 3-Speed Blink | 256 Colors
AGP-3300L Monochrome LCD Monochrome, 16 Levels, 3- Monochrome 16 Levels
Speed Blink
AGP-3300S | STN Color LCD 4096 Colors, 3-Speed Blink | 256 Colors
AGP-3300T TFT Color LCD 65536 Colors, No Blink 256 Colors
16384 Colors, 3-Speed
Blink
AGP-3400S STN Color LCD 4096 Colors, 3-Speed Blink 256 Colors
AGP-3400T TFT Color LCD 65,536 Colors, No Blink 256 Colors
AGP-3500T 16384 Colors, 3-Speed
Blink
AGP-3500L Monochrome LCD Monochrome, 16 Levels, 3- Monochrome 16 Levels
Speed Blink
AGP-3500S | STN Color LCD 4096 Colors, 3-Speed Blink | 256 Colors
AGP-3510T TFT Color LCD 65,536 Colors, No Blink 256 Colors
AGP-3560T 16,384 Colors, 3-Speed
AGP-3600T Blink
AGP-3450T
AGP-3550T
AGP-3650T
AGP-3750T
LT-3201A MonochromeLCD 8 Levels, No Blink Monochrome 8 Levels
(Umber)
PS3651A TFT Color LCD 65,536 Colors, No Blink 256 Colors
PS3650A 16,384 Colors, 3-Speed
PS3700A Blink
PS2000B
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» Objects with the blink setting option blink on the display and have three
selectable blink speed rates.

§~ «9 5.2 Setting Blinks” (page 9-37)

» On monochrome LCD models and STN Color LCD models, when you set a
tiling pattern in the background settings to use the blink setting, some drawing
components that do not have the blink setting may blink. Please confirm the
display in advance.

B Defining Colors

Set the object colors. Depending on part type, setting items such as colors of a border, fill,
shadow or label, differ depending on the part type.

For a 256-color supported model For a monochrome 16-level supported model
i Rectangle [x]
— ¥ Border 1 Border
Line Type — Solid Line = Line Type — Solid Line =
Line Thickness  fi =& ine Thickness |1 =g
Display Color [ 15 | Blink  [Hone 3| = dor  [C315 ~| Blink [None |
Pattern Color [0 = Bk [ie =l [ i
attern Color [0 I = [ g |
Chamfer W Fil Chamier i
[ee =] | Fattem None = Nona - [Hore |
Humber of PIXEIS_‘% Display Golor 'E;E j Blitk  [lore 7] Number of Firels Display Color ~ [C115 = I |
z Paitstn Callst o T g = Pattern Color Corrent Coler: [ ]1§ : {255.255.258)
7 Shadow
e e AlBBaEE0
Color (w5 G . o [0 11 [ 12|13 s
Shadow Distance  ff =k | Shadow Distance [£ =) |
Gancel 0K Q) Cancel

* For 256-color supported models, you can move to the next palette with the
scroll button at the bottom of the color palette.

* You can only select [ Transparent] for the [Pattern Color] for a Switch Lamp
that does not use the [Lamp Feature] or for aKey that has a[Pattern] set in
the settings dialog box.

* When you change from amodel that supports more than 16 colorsto a model
that supports only 16 colors, any colors outside the 16 color range are
converted to one of the 16 colors.

MPORTANT For a monochrome 16-level model, there are some cases where color
distinction is difficult or where flicker is caused. Use the color designation
above after confirming the colors.
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|

& Color Palette

Curremt Color: [ 7 : (ZEE.ZE5_ZEE) . . .
Aal: |- | B E i
A E BEOE |5 H E
]l | = =l 5 B
e 0

106 kd -
40 45 | a7
e - "
“© | B = =
= Gl o
. . 58 | 58 |60 | &1 |62 |63
« »
Current Color: []7 : {255.2E5.2EE) Current Color: [ 17 : (255.285.255)
[ i == |f= [= == S
. . Ea | E10 | E11 | E12
m 215
219 223
=
« »
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9.5.2 Setting Blinks

Blink makes the object blink on the display and has three selectable blink speed rates (Slow,

Medium, Fast).

[Fast] istwice the speed of [Medium] and [Slow] is half the speed of [Medium]. If you select
[None], the object will not blink.

« For dark color blink, refer to “5.14.6 [System Settings] Setting Guide |
[Display Unit] Settings Guide 4 Display” (page 5-110)

,-}“ Rectangle

—w Border

Line Type

|——5alid Line

Line Thickness I Eg—

Display Golor  [C37

Pattern Color [0

Bl

Blink

ik

Chamfer — M Fil
I Mone - I Pattern

9.5.3

Setting Line Types

| Mahe

j

| More

You can select the line type from five types: [Solid Lin€], [Dotted Ling], [Dash Ling], [Chain
Line], or [Two-Dot Chain Line].

Chamfer
[rame ~1

Mumber of Fixels

— ¥ Border

Line Tvpe [— Solid Line ~1
Line Thickne:
Display Color Blink  [None ~]
Pattern Colar Elirik [Hone B |
— I~ Fill —]
Patter: n I =1
Display Col | — — =] Blink [Mons ~1
Pattern Color =1 Blink [riene =1
—
Direction [Bottom Rieht ~]
Sl o =1
Shadow Distance o =] ==

954 Setting Patterns

Select a pattern from the following nine types.

.ff: Rectangle

Chamfer
I Mahe hd l

Mumber of Pixels

F =4

— v Border

Line Twpe [— Solid Line =]

Line Thickness hﬁg

Display Golor  [EE15 x| EBlink  [Mare j

Pattern Color [0 =] Blink  [Hare j
— I Fill

Pattern -LGhanLEaﬂe{n {Large) ~|

Digplay Colal | Blink |None j

Pattern Color, ;I Blink. INone j
|—|7 Shadow
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9.6 Editing a Part

9.6.1 Editing Parts

Lamp

e» Ea i,

Edit Sor
- [ 4 F ]

1 From the [Parts (P)] menu, point to [Switch Lamp (C)] and select [Lamp (L)] or click g .

2 Movethe pointer -l to the drawing screen and the pointer changes to a cross-hair cursor

4B

3 Drag to the location where you want to place the switch. The switch is placed in the area
whereit is dragged.

* You can also drag and drop a part from the Parts Toolbox .
From the [View (V)] menu, point to [Parts Toolbox (T)], [Work Space(W)]

and select [Parts Toolbox (T)]. The Parts Toolbox appears. You can view
different parts shapes by setting the [Parts Palette] and [Type].
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4 Double-click the placed Lamp and the following dialog box appears.Click the keypad icon

.i‘_‘: Switch/Lamp

Parts ID Switch Feature Lamp Feature loolor ] Label ]
EL_DDDD —]
Comment ¥ Lamp Feature

2>Extended
Eit Address

[[PLC1 00000 ==

OFF

Select Shape

Help (H) ok@ |  cancel |

5 Click the keypad icon | and enter the bit addressin the [Input Address] dialog box.

#* Input Address
Bit Address
|[P LC1 100000 - i = ' Device/PLC [PLCA -
Copy fram Lamp | Copy to Lamp | |>< ﬂm
Back . Clr
AlB|C Flefla
DIE|F 415 E
112 3
1} Ent
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6 Click the ;I icon and select the [Device/PLC] and [Device]. Input an address from the
keypad.(For example, M100)

Device/PLC IPLO1 vl Device/PLC IPLO‘I 'l Device/FLC IPLE1 'l
7~

P Jd [ T X =|ho X =|[100
i oo Back . " Back oo

7la|a ale|cC 7lals ale|cC 7la|a
g 4|58 D|E|F 4[58 D|E|F 4|58
F 1]2]3 1]2]3 PO
TS - Vs

1] Ent 1] Ent Ent

—

ﬁ[PLm TMO0 DD; ==

Copy from Switch I Ciopy to Switch

* Input the address with the keypad on the [Input Address] dialog box. If you
input it directly with the PC keyboard, it may not be recognized as an
address.

7 Click [Select Shape] and the [Select State Window] appears.

.;g"'_‘: Switch/Lamp

Parts ID Switch Feature Lamp Feature |Oo|0r | Label |
FL_DDDD Eﬁ
Comment ¥ Lamp Feature

2>Extended
Eit Address

J(PLGTIMO100 =

Gopy from) Switch | Copy to Switeh |

Help (H? | (o] giw)] Cancel
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8 Select [State 0] and click [Open].

,f_‘: Select State Window

State 0 State 1

oK | Cancel |

9 Select [Standard Parts] from the Parts Palette. Next select the [Part Number]
SW_3D202_OFF picture.

,f_‘: Shape Browser
Parts Palee Standard Parts V’ Erowsze..
State |State 0 j

DE]E] P

Mew Palette Create Delete oK

» Usethe Parts Palette drop-down list to change the images displayed. There
are parts with 65536, 256 or 64 colors. Please select the parts pal ette that
matches the colors supported by your model.

10 Click [OK] and the display returns to the [Select State Window]. Select [State 1] and click
[Open].

,f_‘: Select State Window

Auto 0K | Cancel
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11 Select [Standard Parts] from the [Parts Pal ette]. Next select the [Part Number]
SW_3D202_ON picture and click [OK].

,f_‘: Shape Browser
Parts Pale'@ |Standard Parts )_| Browse..
State [State 1 x|

_]

( oK n Cancel |

12 The pictures at [State 0] (OFF) and at [State 1] (ON) are displayed in the [Select State
Window]. Click [OK].

,f_‘: Select State Window

Auto Open . T Cancel

* Click [Auto] after defining the picture in [State0] to automatically match the
NOTE :
picturesfor al the other states.
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13 Click the[Color] tab. Confirm that [ Select State] is OFF and set the color of the switch for
the OFF state. For the [Display Color], click j and select a color from the color palette.

.i‘_‘: Switch/Lamp

Parts 1D Switch Feature ] Lamp Featurd ' abel ]
L_0oon -
Comment Select State OFF ~ |
Display Colar /2 j Elink. |N0ne j

Pattern Current Color: [z : (0.255.0)

3

Eorder Color

OFF

Select Shape E .

L
.ﬂ -

3

o oo
. @ H

oy (X
(%) =
o [
=1 %)

33 34 35

48 49 50 51 .

a6 a7 a8 a9 B0 61 B2 B3

Help (H? & » DK ) Cancel |

H
.
m

47

* You cannot edit the color for the Switch/Lamp menu image parts.

14 Select ON in [Select State] and set the color of the switch for the ON state.

Select State |OFF =]
CFF

Dizplay Calor

.i‘_‘: Switch/Lamp

Parts 1D Switch Feature ] Lamp Feature Color l Label ]

EL_DDD‘I —]

Comment Select State (o1} -
Display Golor |- 4 j Elink. |N0ne j
Pattern ] -
Border Color —7 ~| Blink Mone -

Select Shape
Help (H) ok@ |  cancel |

* You cannot edit the color for the Switch/Lamp menu image parts.
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15 Select the [Label] tab. Select [OFF] in [Select State] and input the text to display on the
switch in the OFF state.

Parts ID Switch Feature ] Lamp Featurb9| 1

Lo -

Gomment

Font
Fant Type Standard Font ¥ | Size B x 16 Pixels -
Display Language Japanese w | Text Attribute Mar mal M

i+ Direct Text " Text Table

OFF ( Start, Text Color Elink.
_selectShae_| 57 5 fere

Shadow Galar Blirk.
(i - | Bl

Backeround Color — Elink

Copy to Al Labels | Glear All Labats | [Transears =] | =

W Fixed Position [~

Line Spacine |0 = ﬂ ==

Help (H) oK@ | GCancel |

16 Select [ON] in [Select State] and input the text to display on the switch in the ON state. (For
example, STOP)

Select State OFF

Fant

.i‘_‘: Switch/Lamp

s ID Switch Feature] Lamp Feature] Color  Label l
Comment (+ Direct Text " Test Table
Select State i} -
Fant
Fant Type Standard Font v | Siee ’m

Display Language ASCI | Test Attibute Harmal h

‘Stop’ Text Color Blink
Select Shape ||:|? j |N0ne ﬂ

Shadow Color Elink.
- [ ] |
Background Color Blink
CopytosliLabels | CleardllLabels | | Transparent = | |

¥ Fized Pasition -

Line Spacing mﬂ SHEIE

Help [H] QK. () | Cancel

17 Click [OK] when all the settings are complete.
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9.6.2 Registering New Part Image

Use the following procedure to register new images for parts.

1 Double-click the part you want to register a new image for, and the following dialog box
appears. Click [Select Shape].

.i‘_‘: Switch/Lamp

Parts ID Switch Feature ]Switch Common ] Lamp Feature ] Caolor ] Lakel ]
EL_DDDD E
Camment v Switch Feature | A A EI
= WS e S
ulti-function Lis
Eit Switch T g ““Q‘-l e =
4 S o cresn pecia electar
BitSwitch  Guitch  Chanee  Switch  Switch
Bit Address 22Edended
[PLCA 00000 -|=
| Mormal |
e | |
Select Shape Bit Action
MO Shape Bit Set -

fidd
Copy and fdd

Help (H? (o] giw)] | Cancel

2 The[Shape Browser] dialog box appears. Click [New Palette].

,i‘_‘: Shape Browser

Erowsze..

Parts Palette  |SiElacita A

State State O

=
._]. |
=l

Parts Mumber |

MNew Palette §Create Delete | Cancel |
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3 The [Save As] dialog box appears. Define the [Location(1)] and [File Name (N)] of the new
parts palette you and click [Save (9)].

[ 71|
Save i I@pdx j - £k B
pdb |25 |_OperationMark2.pds  [25'1_RectangleT hin3. pdx @ |_Walve.pdx
@ |_ArrowCircle. pds @ |_Operationkd ark 3. pds @ |_Selector. pd= @ Image2b6_EXT
@ |_Arrowkdetal pds @ |_Operationkd ark4. pds @ |_Sign.pds @ Img_blue25E. po
@ |_ArrowS quare. pds @ |_Pipe.pds @ |_SignSmall pds @ Img_blueE4. pd:
@ |_Blower. pds @ |_Pump.pds @ |_Silver. pds @ Img_grayn. pd=
@ |_Circle.pds @ |_Rectangle. pd= @ |_Slide. pdx @ Img_gragr. pds
QI_EircleFrame.pdx QI_HectangleThick‘l.pdx QI_Tank.pdx @Img_green258.|
@I_Equipment.pdx QI_HectangleThickZpdx QI_ToggIe28tate1.pdx @Img_green&l.pn
QI_GDId.pdx QI_HectangleThickS.pdx QI_ToggIe28tate2.pdx @Img_orange25E
@ |_Motor. pds @ |_RectangleThinl.pds @ |_Toggle3Statel. pd= @ Img_orangefd.|
@ |_Operationkd ark 1. pds @ |_RectangleThinZ. pds @ |_Toggle3StateZ pd= @ Img_red256. pd;
4] | i
ile name: Itest 'l
Save as ype: Ilmage Parts File 'l Cancel
Comment |
4

4 When the following message appears, click [Yes (Y)].

C¥ProEx¥STEP3¥Module¥pdx¥test bdx does not exist.
Do wou want to create it?

Mo |

5 The newly registered [ Shape Browser] dialog box appears. Click [Create].

#* Shape Browser E

Parts Palette Itest.bdx VI Browse.. |
State IState 0 vl

| v

Parts Mumber I LI

[elete ]2 Cancel |
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6 The [Register Parts] dialog box appears. Select [State 0], and click [Select].

.?":: Register Parts{test.bdx)

State 1 State 2 State 3

State 4 State § State 0 State 7

State & State 8 State 10 State 11
State 12 State 13 State 14 State 15 =
Title | ‘ Select Eelete

i Color
Set the number of colors at Image —> Parts conversion.

4008 Colors vl v Compress

4

7 When the [Open Fil€] dialog box appears, navigate to theimage location [Look In], select the
file [File Name] and [Look in] and [File name] and click [Open].

DOpen File EHE

File name: Ileft.bmp 3
Filez of type: IAII Image Files j Cancel |

7
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8 Theimage will be registered in [State 0] of the [Register Parts] dialog box.

._-éf: Register Parts{adsf.bdx)

State 0 State 1 State 2 State 3
State 4 ‘ State 5 State £ State 7
State B \ State 9 State 10 State 11

State 12 \ State 13 State 14 State 15 =

Title:

Lkt

Calar
Set the number of colors at Image -» Parts conversion.

4096 Colors | ¥ Compress
Register Cancel
4

9 If necessary, set the part number and number of colors for theimage to register in [Title] and
[Color Settings], and click [Register], to complete the process.

'Sl'ﬁasri]e'ct an image for the part, open the Parts dialog box and click [Select
The [Shape Browser] appears. Select a palette name in [Parts Palette] . Select
the appropriate image and click [OK].

* If you click "Create" while a previously registered part is selected, you can
edit that part image. To create a new image, click the "Create" button while
no previously registered part is selected.

 Image parts can be registered with a maximum size of 160 x 160 dots.

 Parts which use registered images can cause large project file sizes. It is
recommended you set [Compress] in the [Color].

* You can register up to 200 image partsin asingle parts palette file.

 Image parts that have been enlarged or reduced may display differently on
the GP and in Pro-EX.

» When the registered image size is different depending on the state, the larger
image will remain the same, and the smaller image will be enlarged.

* You cannot register or delete a previously-prepared PDX file.

» Thetypes of image file that can be registered to a part are BMP, JPEG, DPD,
and PNG
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9.6.3 Fixing/Unfixing Objects

@ Fixing Objects
Place drawings and parts, and a blue fixed pi n appears at the top-left corner objects on the
screen. Click add space on the pin and it turn red the object cannot be selected or edited.
When you put the cursor over the object, a"lock™ mark appears to the right, indicating that
the placement position is fixed.)

‘w k4 °=

Click the blue fixed pin The fixed pin turns red to
indicate the part is locked

@ Releasing Fixed Pins
» Releasing individual objects
Double-click a drawing or part, click and the pin turns blue.

» Releasing all fixed pins on the screen
From the [Edit (E)] menu, select [Release All Fixed Pins (K)].
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9.7 Using a Screen for Various Purposes

9.7.1 Setup Procedure

B1

Setting Input
Screen

Active Operations
B100 Screen

B3
U W [ W esms rmscocn | Active Monitoring
3 J Screen
Create a screen for various I e el

purposes.
You can call and display

various screens.

1 From the [Screen (S)] menu, select [New Screen (N)]. The following dialog box appears.
Click [New] to create a new base screen (Example: Base Screen 2)

#* New Screen E

Screens of Tvpe  |{SERE

Screen P E g
Title IUntitIed
Uze Template

Select Template from List
Becently Uzed Template

e Cancel |

2 From the [Draw (D)] menu, select [Call Screen (O)] or click X .

| Drawt (D)
Select Range (E)

A Text(s)

Dat (D)

Line (L)

Palyling (L)
Rectangle (R)
Palygan ()
Circley/Oval (C)
ArcPie (A)

Scale (M)

Image Placement (1)

B Call Screen (0]}

B Tabke (D

B~ 00O a ™~ -
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3 When you drag on the image screen, a dashed line is drawn. [Call Screen] dialog box is

displayed.
#* Call Screen
Gall Tareet Humber
Base Screens =] [——— -

OF {03 Gancel
4

&%

4 Select the target image from [Call Target].

Base Screens Previously created base screens are displayed.

Image The image data registered in "Image Registration” is displayed.

Image (CF) The CF-card image data registered in "Image Registration” is
displayed.

Mark Registration Displays registered marks.

Keypad The keypads registered in "Keypad Registration” are displayed.
Registration

,f_‘: Call Screen

Call Target Mumber

Image (CF)
Mark Registration
Kevpad Registration

ok@ |  cancel |

4

» When you call a[Base Screen], call and placeit in the center of the screen.
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5 Select animage and click [OK] to display the designated image.

t input scre riving operation scres i ; arm screenE
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Editing a Picture on Another Screen
9.8 Editing a Picture on Another Screen

9.8.1 Placing Pictures Registered in the Package

Drag and Drop

Package

(] O

Objects registered in Place it on the screen and edit it.
a package

1 Display the registered picture list. From the [View (V)] menu, select [Package (P)].
Yiew (i)
Work Space (W) »

Tool Bar (T) 4
Status Bar (5)
|§J Package (P |

B Header (H)
% Footer (F)

Zoom (2) 4

Zoom Biox 4
Ediiting Area (B) 4

Murmber of States (Mk
Change Language (L}

Prafarences (0)

2 The[Package List] dialog box appears. Select the picture to place and click [Open].

Mame | Creation Date

DEC Keyboard 27/06/2005
HEX Keyboard 27/06/2005
Text{BBC/ENG! Keyboard 27/06/2005
TextDWE/ENG) Keyboard 27/06/2005
Text{BBC/ PN Kevboard 27/06/2005
Text {WESJPN) Kevboard 27/06/2005
Text{KANAT/JPH} Kevboard 27/06/2005
TextiKANAZS PN} Keyboard 27/06/2005
Small DEG Kevboard 27/05/2005
Small HEX Keyboard 27/05/2005
Small Text(AEC/ENG) Kevboard 27/05/2005
Small Text(AEC/ PN} Kevboard 2 5

Mew Open [elete Rename | Cloze /I

s
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3 The [Package] dialog box is appears. Select a picture and drag it to the drawing screen to
placeit.

Change Delete

GP-Pro EX Reference Manual 9-54



Editing a Picture on Another Screen

9.8.2 Registering Pictures in the Package
You can register a created object. You can also register a combination of multiple objects.

1 From the [View (V)] menu, select [Package (P)], or click ] .
2 The[Package List] dialog box appears. Select a package name and click [Open].

#* Package List
Mame Creation Date

DEC Keyboard 27/06/2005
HEX Keyboard 27/06/2005
Text{BBC/ENG! Keyboard 27/06/2005
TextDWE/ENG) Keyboard 27/06/2005
Text{BBC/ PN Kevboard 27/06/2005
Text {WESJPN) Kevboard 27/06/2005
Text{KANAT/JPH} Kevboard 27/06/2005
TextiKANAZS PN} Keyboard 27/06/2005
Small DEG Kevboard 27/05/2005
Small HEX Keyboard 27/05/2005
Small Text(AEC/ENG) Kevboard 27/05/2005
Small Text(ABC/ PN} Kevboard 27/05/2005
kevboard 23/10/2006
23 006

Mew | Open | Delete | Rename | Cloze |/

s

* To register picturesin anew package, click [OK].

3 The[Package] dialog box, which displays aregistered package list, appears.

figure: -

Change Delete
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4 Select the figure to be registered and drag to the [Package] dialog box.

figure

Change

5 The pictures have been registered in a package.

figure

- Jum]

Change Delete
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9.9 Creating a Screen from a Template

9.9.1 Setting up Grids

B Introduction

You can display a grid with dots or lines on the drawing screen for reference when placing
multiple objects.

The position of each object is determined according to the intersecting points of the grid, to
make it easier to adjust the object position.

B Setup Procedure

 Please refer to the settings guide for details.
F~ “9.12.2 Preferences [Edit Screen] Setting Guide” (page 9-79)

Display alined grid on the drawing screen and set the environment for placing an object
alongaline.

MENU

. fActive
Setggpgegnput Operations
creen

fictive
Moni toring Sﬁclraererg
Soree
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1 Fromthe [View (V)] menu, select [Preferences (O)].
2 The[Preferences] dialog box appears. Select [Screen Edit Style].

@®* Preferences

Settings for Screen Edit Style

Action
Logic Edit Style Show Guide on Move or Resize
l‘éﬂonlt%rhStip W Left Edee [T Horizontal Center [~ Right Edee
fror Lhec [+ Upper Edee [ Wertical Center [~ Bottom Edee

V¥ Snap to Grid

Grid Size (ixels)  Width PO =] Heieht F0 =
Dizplay
[v Show Fixed Pin of Parts
[v Show Ruler
v Show Grid

Order Back - Shape  |Grid -
[~ Show Parts ID
[~ Show Address
[~ Show Touch Area
[ Show Window Parts Screen

ok@ |  cancel |

4

3 Set the Action to align objects with intersecting points. Put a check mark next to the[Snap to
Grid] box. Set the grid spacing in [Grid Size] (by the pixel). (For example, [Width] 20,
[Height] 20)

@®* Preferences

Settings for Screen Edit Style

Seript - Action

Taoolbar Shaw Guidh M Resi

Logis Edit Style ow Guide on Move or Resize

Monitor Step W Left Edee [T Horizontal Center [~ Right Edee

Ei Check.
fror Lhecl ¥ Upper Edee [~ \fertical Center [~ Bottom Edee

V¥ Snap to Grid
Grid Size {pixels)  Width PU = Height PU —]

Dizplay

[v Show Fixed Pin of Parts
[v Show Ruler
v Show Grid

Order Back - Shape  |Grid -
[~ Show Parts ID
[~ Show Address
[~ Show Touch Area
[ Show Window Parts Screen

ok@ |  cancel |

4
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4 Inthe Display group box, select the [Show Grid] check box. Select [Order] and [Shape]
options as necessary. Click [OK] to close the dialog box.

@®* Preferences

Settings for Screen Edit Style
Action
Iggilc‘?aédit Style Show Guide on Move or Resize
l‘éﬂonlt%rhStip [V Left Edee " Horizontal Center [~ Right Edee
rer e v Upper Edee [ Vertical Center [ Bottom Edee
V¥ Snap to Grid
Grid Size {pixels)  Width PU = Height PU —]
Dizplay
[v Show Fixed Pin of Parts
[v Show Ruler
v Show Grid
Order Back - Shape  |Grid -
[~ Show Parts ID
[~ Show Address
[ Show Touch Area —
[ Show Window Parts Screen
ok@ |  cancel |
4
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9.9.2 Selecting a Screen from Template

You can reduce the number of drawing processes by editing in a screen registered in the
templates.

Select a template.

7dN

Template List
Screen Screen Screen
Image 1 Image 2 Image 3 Screen |mage 3
Screen Screen Screen
Image 4 Image 5 Image 6

B Placing a Picture Registered in Templates
1 From the [Screen (S)] menu, select [New Screen (N)].
Screen (5)

|ﬁ Mewy Scresn (M) |
B open Screen (00
Close Screen (C)

e |

= Mext screen (F)

Screen Information (1)
Change Yiew (W) 3

Register Template (T)

2 Thefollowing [New Screen] dialog box appears. Click [Select Template from List].

Screens of Type
Screen
Title |Untitled

Uze Template

( Select Template from List )
Becently Used Template

Mew Cahcel
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3 The registered templates display. Select a screen you want to use and click [OK].

,_i'_‘: Select Template

Screen Number: 2 rtitled

3 Delete \ﬂ Fename

Cancel |

4

4 The template is placed.

Setting Input g; 0 clive §§ Gtive gg Alarm §
| perations Monitoring
§ Screen Screen Screen Screen
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B Registering a Screen as a Template

You can register created screens as templates and use them again. To make a screen into a
template, from the [Screen (S)] menu, select [Register Template (T)]..

Screen (5
B MNew Screen (]

B open Screen (Q)
Close Screen ()

b |

Screen Information (1
Change Wiew () r

Redgister Template (T) |
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Pasting an Image

9.10

9.10.1

Target Image

Pasting an Image

Image data that can be displayed on the GP screen is as follows.

Registration

registration”

Image Pasting Method | Description
BMP, JPEG, | Directly placing an | Directly pastes BMP, JPEG, DPD, or PNG on the screen.
DPD, PNG image on the
File scregen
* In using the same image on the multiple screens, you can
hold down the screen capacity by registering the origina
imagein "Image".
* You can call the base screen with an image already placed
onto another base screen.
5~ «9.10.2 Pasting BMP/JPEG Procedure” (page 9-64)
Registering an Registersa BMP, JPEG, DPD, or PNG file asthe "Image”
igag? in "|m?jge and displays it on the base screen by using Call Screen.
isplay)" an
Elsing Cya)ﬂl Screen
* You can improve screen capacity by registering an image
filein "Image" and using the same image on the multiple
screens.
5~ w97 Using a Screen for Various Purposes” (page 9-50)
Registering an Calls and displays the image data stored in the CF Card on
image in "Image | the base screen.
(CF)" and using &~ 9.7 Using a Screen for Various Purposes” (page 9-50)
Call Screen
Calling the base | Calls and displays the base screen’s already created image
screen's image data on the base screen.
& w97 Using a Screen for Various Purposes” (page 9-50)
Mark Registered "Mark | Calls and displays the dotted image data registered in

"Mark" on the base screen.

images. &~ 911 Drawing a Detailed Picture” (page 9-66)
Keypad Registered Calls and displays the registered keypad on the base screen.
Registration | "Keypad &~ 9.7 Using a Screen for Various Purposes” (page 9-50) ]
Registration”
images.

* You can call one keypad from a[Call Screen] part on a
Base Screen.
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9.10.2  Pasting BMP/JPEG Procedure
To directly paste the image on the screen:

Profare Pro-face

BMP, JPEG, etc.

Converts image data and
places it on the screen.

1 From the [Draw (D)] menu, select [Image Placement (1], or click the B icon.
Draw (D)
Select Range (E)

A Text (3

+ Dot (D)

/ Line (L)

A Paline (L)
O Rectangle (R)
O Palygon ()
O CrelefCval (C)
" Arc/Pie (A)

E scale ()
|E Image Placement (I_)|
Bl soreen (0)

B Tabk (D)

2 Move the cursor to the drawing area and the cursor converts to cross hairs. Click the screen
and the [Open Original File] dialog box appears. Set the [Look in] and [File name] for the
image to paste.

(SR ERSTIRTT ] < (W open original File

3 GP-Pra B 200 =« @ gF B =

| backup ek,
|=cm [E)Package
|cmse D)Parts

| Converter (Dipde

| Database S)Prop
|CoFonT [CProtacal
| Fanks Dsystem

|C I0Driver

| Manual

@ name [proface.bmp =l Op
Files of type: |4l Imags Files = Cancel

4

Biightness )
i Light Quality Coarse |
"""" ) ct Feduce Colors [ 16384 Calors |

Mirrar Nane

Standard [T Transparent [Tl |

1

1

4
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3 Adjust the image quality and number of colors, and click [Open].

My Network P...

File name: Iproface.bmp

Brightness

Standard

i

Filez of type: IAII Image Files

Faded Light

j Open I
j Cancel |

Quiality I Coarze - l
Reduce Colors 16384 Colors ﬂ
Mirrar 8 Colars -
16 Colors o
™ Trarsparent £4 Colors
4036 Colors

16384 Colors

VITCD Cdern

4 Thefollowing [Image] dialog box appears. Set the size and blink rate for the image to paste.

,;g"'_‘: Image [ %]
Original File
C:\Program Files\.. \proface. bmp Browse... |
pmlm Number of Colors ~ 16.777.2 Size 425x 85
INDE Hlectronics | 12 Foxspectiise
¥ Original Size
[~ Blink [~ Compress

QK (D) Cancel

* When [Original Size]

isselected, animageis placed with the same size asthe

original image. You cannot change the image size after placing it.
» When [Fix Aspect Ratio] is selected, an image is placed with the original
image horizontal to vertical ratio fixed.

5 Click [OK] and the designated image

will be placed.

|§ Base 1{Untitled |
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9.11 Drawing a Detailed Picture

9.11.1 Drawing a Valve

B Introduction

You can call and display image data created in a Mark to the base screen. In the [Mark], you
can draw your own symbols or pictures with dots.

[ Base 1(Bulb) B4 & Mark Registration 1{Mark Resistration} |

B Setup Procedure

[ Base1{Bulb} | N Mark Registration 1(Mark Ree.) B4

|---0 --------- T AR [

 Please refer to the settings guide for details.
¥~ %9.12.3 Common (Mark Registration) Settings Guide” (page 9-81)

To draw a valve with dots;

e
e .

T,

= 0
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1 From the [Common Settings (R)] menu, click [Mark Registration (M)]. Select [New] and
enter the [Number] and [Comment] and click [Create] (Example: [Number]1, [Comment]
Mark Registration)

.;g"'_‘: New Mark,/Open

Mumber I E g

Comment |Mark Registration

e Cancel |

4

2 Create an outline of the valve body with a rectangle. From the [Draw (D)] menu, select
[Filled Rectangle (T)]. Place after dragging to adjust the size and location of the rectangle.

[ Base 1(Bult) B & Mark Reeistration 1{Mark Registration B4

] e
e
B @

Bl. I
e
e e

» From the [Edit] menu, click [Undo (U)] to undo the command.
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3 Create avalve opening with an ellipse. From the [Draw] menu, select [Filled Circle/Ellipsg],
Place the object after adjusting the size and location of the ellipse.

[ Base 1(Bulb) B4 & Mark Registration 1{Mark Resistration} |

T g
.

4 Create an outline of the valve opening using [Color Inversion]. From the [Edit] menu, select
[Calor Inversion (Y)] to mirror the dot on the campus. In this state, from the [Draw] menu,
select [Filled Circle/Ellipse] to place after adjusting the size and location of the ellipse. After
placement, click [Color Inversion (Y)] again to return to the campus state.

o

& Base 16ul) B4 Mark Reeistration 1(Mark Reeistration? B

'S
iy

EERA
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5 Create the handle part with an oval and rectangle. From the [Draw] menu, select [Circle/Oval
(D] or [Filled Rectangle (T)]. Place the object after adjusting the size and location of the oval
and rectangle.

[ Base 1(Bulb) B4 & Mark Registration 1{Mark Resistration} |

6 Finetune each part using dots. From the[Draw (D)] menu, select [Dot (D)]. To draw, you can
click to turn ON (white) and right-click to turn OFF (black).

[ Base 1(Bulb) B4 & Mark Registration 1{Mark Resistration} |

-
.
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7 Click the [Base 1] tab and open a base screen to place the mark. From the [Draw (D)] menu,
select [Call Screen (O)].

Draw (D)
Select Range (E)

A Text(s)

* Dot (D)

/ Line (L)

A~ Palyline ()
O Rectangle (R)
& FPolygon ()
O CirclefOval (0
7 BrcfPie (A)

E Scale (M)
B Image Placement (1)
B Call Screen (u)]

B Tk

» From the [Screen (S)] menu, select [New Screen (N)] to create a new base
screen.

8 Click the drawing screen and the dotted border is placed and the [Call Screen] dialog box
appears.

,f_‘: Call Screen
Call Target Mumber

| Baze Screens j || j

ok@ |  cancel |

4
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9 Select [Mark Registration] from [Call Target] and select the mark number registered in
[Number]. (For example, 1)

#* Call Screen E

Call T arget i

M ark. Registration hd ! ﬂ

1. Mark Registr...

Size ‘ Dizplay Calar \ Background Color
11 times j ll:l? j IN'ne j I-D j INone j
oK@ | Cancel |

4

* You can designate the display color of the created mark.

10 Select an image and click [OK] to display the designated image.

[ Base1{Bulb} | N Mark Registration 1(Mark Ree.) B4

|---0 --------- T AR AR
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9.11.2

Displaying a Character External to the Character Code

Draw an external character with dotsin Mark. You can display registered external characters

on the screen.

You can register external characters only when selecting the ASCII standard font (bitmap
font) and the font size of 8 x 16 dots or larger.

Mark Registration

B Setup Procedure

You can display the created character on the screen by replacing a character in the framein
the character code table with it. The following is the procedure for replacing the character é
(89h) in the character code table (Code Page 850) with the character "111", which was created
with dots, and displaying the character "I11" on the GP screen.

& Character Code List

GP

The following is the character code table of Code Page 850, the character code used on the

GP.

B123456789abcdelf
G R R R REREBREREBRE
IR REEBRRREREERRRERER R
2 * TS A& C) s+, - F
3|l 123456789 : ;<=27>»7?
4 PABCDEFGHIJELHMNOD
SIPQRERSTUVUX YZLNIT_ Corresponds to
6l abcdefghiikln
Tlpgrstuvuxys= i
raguéaaaagém
JEE Ao oonadiyjoiliefexF
alaioanN22iB@q%Hdi=»=»
hE BB |H10daaB4 | 3de¥-
olticb-+adbpdgp=tu
dlE PEEE "III-! B! I™
el oo dpErbPO0OGY "
Fl-2 =3NS+ _ e = .1 312 4
. J
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1 From the [Common Settings (R)] menu, select [Mark Registration (M)]. Select [OK] and
enter the mark number "8010" in the [Number] which corresponds to the character & (89h) in
the character code table. Click [New].
5~ “ m |nput Code Table” (page 9-76)

.;g"'_‘: New Mark,/Open

* Mew " Open
Humber FD‘ID = g
Comment |Mark Registration

e Cancel |

4

2 Draw aspecial character. Create "I11" to display on the screen.

[ Base 1iuntitled! B4 #§ Mark Registration 8010 (Mark Resistration |
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3 From the [Draw (D)] menu, select [Base 1] and then select [Text (S)].

Draw (D)
Select Range (E)
A Text(3)
« Dot (D)
A Line (L)
A Polyline (L)
O Rectangle (R
O Palygan ()
O CirclefCwal (O
7 ArofPie (4)
E Scale (M)
B Image Placement ([
ﬁ Call Screen (D)
B Tabke (D
4 Place the text on the screen, and double-click it to open the [Text] dialog box.
‘;é‘_‘: Text
" Test Table
Font
Font Type Standard Font v | TextSize 8416 Pixel: =
Display Language ASCI T | TextAttribute Normal -
Direation Haorizantal MED
Color
Test Color =) =l gk [Hone x|
=|=|= Background Color | Trarsparent =l Bk | J
LneSpechs |7 =] 5] Shadow Color [ — JE2 T |
Text
ak. (3] | Cancel
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5 Inthetext input area, enter the [Input Code] as "0235", which corresponds to the text code
(89h), while pressing the [Alt] key. & has been input. Click [OK].
&~ «m Input Code Table” (page 9-76)

Line Spacing mg Shadow Color |-1 LI Elitik INone LI

Backeround Golor | Transparent =| Blink [Hone =

g

oK@ | ocancel |

» The character placed on the drawing screen is & On the screen display of to
the GR, "I11" is displayed.
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|

B How to Display Characters External to the Character Code List

The marks drawn for the mark numbers from 8001 to 8128 are treated as the characters of the
character codes from 80h to FFh. For example, 8001 corresponds to 80h, and 8002 to 81h.

If you create marks for these mark numbers, they will be registered as external characters.
By inputting the input code corresponding to a mark number on the base screen, the character
displayed on the base screen is displayed as aregistered external character on the GP.

B Input Code Table

Mark Text Code Input Code Mark Text Code Input Code Mark Text Code Input Code
Number [Code Page 851 | (Alt + Code) || Number | Code Page 851| (Alt + Code) | Number | Code Page 851| (Alt + Code)

8001 80h 0199 8049 BOh 0130 8097 EOh 0211
8002 81h 0252 8050 B1h 0131 8098 E1h 0223
8003 82h 0233 8051 B2h 0132 8099 E2h 0212
8004 83h 0226 8052 B3h 0133 8100 E3h 0210
8005 84h 0228 8053 B4h 0134 8101 E4h 0245
8006 85h 0224 8054 B5h 0193 8102 ESh 0213
8007 86h 0229 8055 B6h 0194 8103 E6h 0181
8008 87h 0231 8056 B7h 0192 8104 E7h 0254
8009 88h 0234 8057 B8h 0169 8105 E8h 0222
8010 89h 0235 8058 Boh 0135 8106 Edh 0218
8011 8Ah 0232 8059 BAh 0136 8107 EAh 0219
8012 8Bh 0239 8060 BBh 0137 8108 EBh 0217
8013 8Ch 0238 8061 BCh 0138 8109 ECh 0253
8014 8Dh 0236 8062 BDh 0162 8110 EDh 0221
8015 8Eh 0196 8063 BEh 0165 8111 EEh 0175
8016 8Fh 0197 8064 BFh 0139 8112 EFh 0180
8017 90h 0201 8065 COh 0140 8113 FOh 0173
8018 91h 0230 8066 C1h 0141 8114 F1h 0177
8019 92h 0198 8067 C2h 0142 8115 F2h 0159
8020 93h 0244 8068 C3h 0143 8116 F3h 0190
8021 94h 0246 8069 C4h 0144 8117 F4h 0182
8022 95h 0242 8070 C5h 0145 8118 F5h 0167
8023 96h 0251 8071 Cé6h 0227 8119 F6h 0215
8024 97h 0249 8072 C7h 0195 8120 F7h 0184
8025 98h 0255 8073 C8h 0146 8121 F8h 0176
8026 99h 0214 8074 Coh 0147 8122 F9h 0168
8027 9Ah 0220 8075 CAh 0148 8123 FAh 0183
8028 9Bh 0248 8076 CBh 0149 8124 FBh 0185
8029 9Ch 0163 8077 CCh 0150 8125 FCh 0179
8030 9Dh 0216 8078 CDh 0151 8126 FDh 0178
8031 9Eh 0128 8079 CEh 0152 8127 FEh 0247
8032 9Fh 0129 8080 CFh 0164 8128 FFh 0160
8033 AOh 0225 8081 DOh 0240

8034 A1h 0237 8082 D1h 0208

8035 A2h 0243 8083 D2h 0202

8036 A3h 0250 8084 D3h 0203

8037 Adh 0241 8085 D4h 0200

8038 A5h 0209 8086 D5h 0153

8039 A6h 0170 8087 D6h 0205

8040 A7h 0186 8088 D7h 0206

8041 A8h 0191 8089 D8h 0207

8042 A%h 0174 8090 D9h 0154

8043 AAh 0172 8091 DAh 0155

8044 ABh 0189 8092 DBh 0156

8045 ACh 0188 8093 DCh 0157

8046 ADh 0161 8094 DDh 0166

8047 AEh 0171 8095 DEh 0204

8048 AFh 0187 8096 DFh 0158
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9.12 Settings Guide
9.12.1 Text Settings Guide
& Text
" Text Table
Font
Forit Type Standard Font | Text Size 8% 16 Pixelz -
Dizplay Language |ASCI | Text Attribute  |Mormal -
Direction Harizontal |
Color
Text Color =7 | Blink |N0ne j
= =|= Backeround Calor |Transparent j Elirik | J
e spacie g Shadow Colar [ — =l Bk | =]
Text
(o] Qiw)] | Cancel
Setting Description
Direct Text Input text into the Input Text window and place it directly as fixed text.
Text Table Use text from a previously saved Text Table.
& «154 Changing Languages (Multilanguage)” (page 15-16)
Font Type When [Direct Text] is selected:

 Standard Font
You can select a bitmap font from [Japanese], [ASCII], [Chinese
(Traditional)], [Chinese (Simplified)], or [Korean].

IMPORTANT

« The standard font will become bitmap font. The display speed is faster
than with other fonts, but characters may have jagged outlines or
distorted if enlarged/reduced too much.

« The Japanese and ASCII standard fonts are normally transferred to the
GP. If you want to use Chinese (Simplified), Korean, or Chinese
(Traditional) standard fonts, add the language in [System Settings]
window, [Font] page.

& 6.2 Defining Stroke Font and Standard Font” (page 6-3)

Continued
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Setting

Description

Font Type

 Stroke Font
You can select avector font from [Japanese], [ASCII], [Chinese
(Traditional)], [Chinese (Simplified)], [Korean], [Cyrillic], or [Thai].

IMPORTANT

« The standard font will become vector font. Characters are displayed with
smooth outlines if enlarged, but the display speed is slower than with the
standard font.

« ASCII stroke fonts are transferred to GP as a normal operation. If you
want to use Japanese, Chinese (Simplified), Korean, Chinese
(Traditional), Cyrillic, or Thai stroke fonts, add the language in [System
Settings/Font].

& 6.2 Defining Stroke Font and Standard Font” (page 6-3)

¢ Image Font
Displays a Windows font as bitmap data.
&~ 6.3 Image Font” (page 6-15)

When [Text Table] is selected:
Select between Standard Font and Stroke Font.

Display Language

Select atext display language from [Japanese], [ASCII], [Chinese
(Traditional)], [Chinese (Simplified)], [Korean], [Cyrillic], or [Thai].

Direction Select from [Portrait] or [Landscape].
Text Size Select the text size. Each font type has a different size range.
» Character Size
Standard Font: 8 x 8 dot standard unit, 1 to 8 times (8 x 8 to 64 x 64 dot)
8 x 16 dot standard unit, 1 to 8 times (8 x 16 to 64 x 128 dot)
Stroke Font: 6 to 127
» Fixed Size
You can select this option only when the [Standard Font] is selected.
Select from [6 x 10 dots], [8 x 13 dots], or [13 x 23 dots].
« When the [Fixed Size] is "6 x 10 dot", you cannot select [Bold] for the
[Text Attribute].
Text Attribute Each font type has a different range of styles.
Standard Font: Choose from [Standard], [Bold], [Shadow].
Stroke Font: Choose from [Standard], [Bold], [Outling].
Alignment When selecting "Vertical", align the center of text with single-byte and
double-byte characters.
Text Color Set the display color for the text.

Background Color

Set the background color for the text.

Shadow Color

When the [Font Type] is [Standard Font] and the [ Text Attribute] is
[Shadow], choose a color for the shadow.

Line Spacing

Set avaluefrom 0to 255. Thisisonly applicable when thetext ismultiple
lines. This option cannot be used when the [Font Type] is set to [Image
Font].
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9.12.2 Preferences [Edit Screen] Setting Guide

On the [View (V)] menu, click [Preferences (O)]. The following dialog box appears. Select

[Screen Edit Styl€] in the left window.

@®* Preferences

Settings for Screen Edit Style

Action

Taoolbar
Logic Edit Style
Monitor Step W Left Edee [T Horizontal Center [~ Right Edee

Show Guide on Move or Resize

Error Gheck

V¥ Snap to Grid

Display
[v Show Fixed Pin of Parts
[v Show Ruler
v Show Grid

[~ Show Parts ID

[~ Show Address

[~ Show Touch Area

[ Show Window Parts Screen

v Upper Edee [T Wertical Center [T Bottom Edee

Grid Size {pixels)  Width PU = Height PU —]

Order Back - Shape  |Grid -

Setting Description
Guide Display | Thisfunction isvalid when aligning an object with a previously placed
on move or obj ect.
resize Guidelines are displayed at the designated points (the | eft edge and upper
edge, etc.).

Action

fine tune the position.

& «99 Creating a Screen from a Template” (page 9-57)

Snap to Grid | The cursor position is determined from the grid size, you don't have to

Grid Size Designate the grid interval by the pixel.
(pixels)

Continued
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Setting Description
Show Fixed Designate whether or not to show the pin mark when an object is
Pin of Parts selected.
* |f you click the pin mark, the Move and Edit Object functions will be
locked and the pin mark will be red.
Show Ruler Shows rulers at the top and the left side of the screen.
|§ Base 1{Untitled |
| N IR R R R T oo I
2
o
%)
&)
Show Grid Designate whether or not to show agrid.
Show Parts ID | Designate whether or not to show the part ID number of the placed part.
Show address | Designate whether or not to show the address set to the part.
Show touch Designate whether or not to show atouch input valid area.
areas IMPORTANT
 Place each object so that the touch areas do not overlap each other.
Show Window | Designate whether or not to show awindow part screen.
Parts Screen
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9.12.3 Common (Mark Registration) Settings Guide
B Creating Marks

Number T =12
Comment  |Mark Registration
New Gancel |¢
Setting Description
New Creates anew [Mark Registration] screen.
Open Opens a previously created [Mark Registration] screen.
Number Set the [Mark Registration] screen Number to any value between 1 and
8,999.
Comment Enter acomment of up to 30 characters for the [Mark Registration]
screen.
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B Open
#* New Mark,/Open
= Mew
Number] Comment
Number [ |
Gomment | |
[ O | Ganeel |
4
Setting Description
New Creates anew [Mark Registration] screen.
Open Opens apreviously created [Mark Registration] screen.
List of marks Displaysthelist of the [Mark Registration] screensin the project file.
Number Displays the number of each [Mark Registration] screen.
Comment Displays the comment for each [Mark Registration] screen.
Mark preview Provides a preview display of the marks in the [Mark Registration]
screen selected in the mark list.
Number Displays the number of the [Mark Registration] screen selected in the
mark list.
Comment Displays the comment for the [Mark Registration] screen selected in the
mark list.
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B Mark Registration

[ Base 1(Untitled) B4 % Mark Registration 1{Mark Resistration} |

Setting

Description

Preview area

Provides a preview display of the mark's on-screen display size.

Drawing area

Used to draw marks using the drawing operations bel ow, which can be
selected from the menu and toolbar.

-[Dot]

-[Line]

-[Rectangl€]

-[Circle/Oval]

-[Filled Rectangl€]

-[Filled Circle/Ellipse]

-[Fill]

-[Text]

-[Draw Size]

The following items are displayed in the drawing area:
-Origin

-48 x 48 dot grid

-Quadrant (8 x 8 dot area) borders

-Dot ON, Dot OFF (Black), Dot OFF (Transparent)
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9.13 Restrictions

9.13.1  Restrictions for Drawing (Text)

* Whentext is enlarged or rotated, the thickness of some letters may change.
¢ For characters with a character code (0x80 to OXFF), the characters shapewill change due
to differencesin font between GP-Pro EX and the GP.

9.13.2 Restrictions for Pasting BMP/JPEG

« |f you set the background color to the screen used for acall screen, the objects placed on
the screen are not displayed on the GP.

« For acolor dataimage screen, the data capacity islarge, but the display speed onthe GPis
fast. For amonochrome dataimage screen, the display speed on the GP is somewhat slow,
but the data capacity can be saved. Convert screens depending on the purpose.

» If animage screen is placed beyond the drawing area, the part that is outside the areais
not displayed on the GP.

Drawing
Area

« Nesting (caling hierarchy) up to 10-layer (11-fold) is available. However, if the
remaining memory in the PC decreases in operation, the display on the screen may be
omitted. When transferred, the nested objects are normally displayed on the GP.

For example, Double-layer (threefold) nesting.

B100 B10 B1

= a3 433

Call screen B100 Call screen B10
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9.13.3

Package Registration Restrictions

Package register save is executed when you close the GP-Pro EX project.
Up to 200 objects can be registered in one package. To register more than 200 objects,
create a new package and register them in a new category.

9.13.4

Restrictions on Marks

Acknowledge the registered external character after the screen data transmission on the
display unit. The text corresponding to the input text code is displayed on GP-Pro EX.
External characters can be registered only when the English standard font with afont size
of 8 x 16 dot or larger is selected. 8 x 8 dot is not supported.

To create an external character, draw it with single-byte characters (within 8 x 16 dot)
with reference to the origin of the mark creating area (0,0).

External characters cannot be rotated.

When you print text in Alarm, external characters are not outputted. The results
depending on printer types are as follows:

For NEC PR201, EPSON ESC/P, HP Laser Jet, and Text ASCII:

Direct code output of the text codes.

For EPSON PM/Stylus:

Image output of Code Page 850 characters

If you were using the Character code (0x80 to OxFF) of the Western standard fontsin a
CSV filewhile registering external marks, and you want to display the marksin the
Special Data Display [CSV Display] and [CSV Data Transmission] on GP, they will be
converted to the external characters that were registered in the mark screen.

9.13.5

Restrictions for Screen Display

When you reduce the screen edit area with the zoom function, some drawings may not
display correctly, depending on the magnification.
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